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Toon Boom Harmony 17.0.0
Here is the list of changes in Harmony 17.0.0, build 14765 (2019-06-07):
l

Master Controller on page 3

l

Drawing Tools on page 7

l

Drawing Guides on page 9

l

Deformations on page 12

l

Digital Animation on page 13

l

Node View on page 14

l

Effects on page 15

l

Performance on page 16

l

Export on page 16

l

Import on page 17

l

Preferences on page 17

l

Installation on page 18

l

Enhancements on page 18

l

Fixed Issues on page 19

Master Controller
Feature

Description

A new Master Controller wizard, the Stack Wizard, allows you to create a Master Controller that
combines a 2D point widget and a slider widget. It works similarly to the Grid Wizard, except
that it allows you to combine several grids of poses. The 2D point allows you to pose your
character based on the current grid of poses, and the slider allows you to switch between grids.

Stack Wizard
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Feature

Description

A good example of how this can be used is by creating a 2D point widget that sets the angle
your character's head is facing, and a slider that sets its mouth pose. By creating a grid of the
character's head looking in every direction, then creating alternate versions of this grid for each
mouth pose, you can use the Stack Wizard to generate a Master Controller that controls both
aspects of your character.

To use this wizard, create a grid of poses in a scene like you would for the Grid Wizard, then all
the variations needed for that grid of poses. Then, in the Master Controller toolbar, click on the
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Description

Stack Wizard button.
The following new Master Controller widgets can be created in Harmony:
l

l

Button: This widget can be scripted to fire an action when clicked on.

Checkbox: This widget is like a button, except that it toggles on and off. It can be
scripted to fire different actions depending on whether it's switched on or off.

New widgets

l

Label: This widget creates a simple text label inside a rectangle. It cannot be interacted
with, but it can help make other widgets easier to identify.

For more information, refer to the scripting API documentation.
The new Unroll Wizard allows you to "unroll" the original character poses of a Master Controller
into the current scene, and makes changes to them.

Editing Master Controllers

For example, if you have a character with a Master Controller that controls the direction in which
it is looking, you can use the Unroll Wizard to recreate the poses of your character looking in
every direction that were used to generate this Master Controller, into the current scene.
Unrolling a Master Controller can be useful if you wish to make changes to an existing Master
Controller. By unrolling its poses into a scene, you get to make changes to the poses, then
create a new Master Controller that uses the modified poses.
To use the Unroll Wizard, select a Master Controller in your scene. Then, in the Master Controller
toolbar, click on the

Stepped Slider

Unroll Wizard button.

When creating a Slider-type Master Controller with the Slider Wizard, you now have the option
to make the slider "stepped". This means that, when you manipulate the slider, instead of
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Feature

Description

interpolating between the different poses that were used to create the Master Controller, it will
set the character to one of these poses, with no interpolation.
This can be useful if you wish to create a slider to select between a set of poses that are not
meant to interpolate between one another, such as mouth poses..
To use this option, simply uncheck the Interpolate Between Poses option when using the Slider
Wizard.

Pose database storage

When creating a Master Controller in Harmony Server using the Stack Wizard, the Grid Wizard
or the Slider Wizard, you will be prompted to select at which level (scene, job, environment or
global) you want the Master Controller's poses database to be stored.

Show Master Controllers
button

A new button in the Master Controller toolbar,

Nudging Master Controller
widgets

It is now possible to select a Master Controller widget and nudge it in any direction by pressing
the arrow keys.

Persistent Wizard state

When you close the Grid Wizard or the Stack Wizard, the current configuration of its grid or grid
stack is saved to your preferences, and will be reloaded the next time you open that wizard.

Jumping to selected frame

In the Grid Wizard and the Stack wizard, when you associate a point in the grid to a frame, the
current frame in the Harmony user interface is automatically set to that frame.

Show Master Controllers, allows you to pull

a list of Master Controllers in the selected group, and select which ones to display or hide.

In addition to the Label widget, the following Master Controller widgets can be configured to
have labels by setting some of their properties:
l

2D Point

l

Slider

l

Button

l

Checkbox

Labels

This can be done by setting the widget's label property, as well as other related properties,
when creating the widget. For more information, refer to the scripting API documentation .

Customization

It is now possible to make the 2D point widget appear either as circle, a square, a triangle or a
diamond. This can be done by setting the widget's point_style property when creating it. For
more information, refer to the scripting API documentation
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Drawing Tools
Feature

Pen stabilizer

Description

The new pen stabilizer can help you draw smooth, stable lines by stabilizing your drawing
strokes as you draw, without having to smoothen them afterwards and potentially impact
their shape. It works by letting you draw a stroke without generating a line immediately.
Once your stroke is of a certain length, it starts generating a line that trails behind your
mouse cursor or tablet pen. By trailing behind, it can use the information of your drawing
gesture between the line and the current position of your mouse cursor or tablet pen to
generate a smooth line.

This feature can be enabled by adding the Pen Settings toolbar to your workspace, and
selecting either Average or Pulled String in the toolbar's drop-down menu.
If you have a tablet and pen that support reading the tilt angle of your pen, you can
configure the Brush tool to use this information and draw with a tilted tip. A tilted tip is
stretched in the angle in which you tip your tablet pen, simulating the effect of drawing
with a tilted pencil or felt pen.

Pen tilt support

This feature can be used by adjusting the Pen Tilt Sensitivity parameter in the Brush
Properties dialog.
If you have a tablet and pen that support reading the rotation angle of your pen, you can
configure the Brush tool to use this information to rotate your brush tip based on how you
rotate your tablet pen.

Pen rotation

This featured can be used by enabling the Use Pen Rotation property in the Brush
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Properties dialog.
Harmony now allows you to configure the curve by which it processes the amount of
pressure you put on your pen tablet to calculate the thickness of your brush or pencil lines.

Pen pressure feel editor

The Pen Pressure Feel dialog can be accessed by adding the Pen Settings toolbar to your
workspace, then clicking on the

Pen Pressure Feel button.

When drawing straight lines with the

Brush or

Pencil tool using a pressure

sensitive pen tablet, you can drag your pen back over your stroke to adjust or increase its
thickness, as if you were drawing with a pressure-sensitive pen against a ruler. There are
two different approaches to this:
Adjust thickness when drawing
straight lines

l

l

Stroke tool smoothing

Keyboard shortcut for Draw
Behind

Tip Style option for the Contour
Editor

The

If you draw while pressing and holding the Shift key, you will draw a horizontal or a
vertical line.
If you draw while pressing and holding both the Alt and Shift keys, you will draw a
straight line in any direction. If you drag your pen in the opposite direction of your
line, the angle of your line will lock and you will be able to draw over it.

Stroke tool now creates smoother lines with less unnecessary control points.

It is now possible to assign a keyboard shortcut to toggle the

Draw Behind tool

property. This shortcut is listed as Draw Behind under the Drawing Mode section of the
keyboard shortcuts list, and has no default assignment.

The

Contour Editor tool now has a

Tip Style option in the Tool Properties view. This

option allows you to select which style of tips should the extremities of pencil lines be left
with when you select and delete a pencil line segment with the Contour Editor tool.
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Default Tip Style

Synchronize Brush and Eraser
size

Description

When you set the

Tip Style for the

Cutter,

Eraser or

Ink tool in the Tool

Properties view, it is now saved in your preferences, separately for each tool.
It is now possible to synchronize the size of the Brush and Eraser tools. To do this, open
the Preferences dialog and, in the Drawing tab, check Synchronize Eraser and Brush.

Drawing Guides
Feature

Description

Many new drawing guides have been added:
l

The Ruler allows you to position and rotate a simple axis, then draw a line along
that axis, like a regular ruler.

New Drawing Guides
l

The Isometric Perspective guide helps you draw lines that are parallel to one of
three axes: The x-axis, the y-axis and the z-axis. The angle of each axis can be
customized as needed.
This type of pseudo-perspective, also referred to as parallel projection, is often used
in 2D games, computer graphics and schematics to depict 3D objects and
environments without using any actual perspective, foreshortening or 3D rendering.
In 2D animation, it is often used to draw long panning backgrounds from a low or
high angle.
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l

The 3-Point Perspective (Horizontal Pan) guide helps you draw horizontally
panoramic backgrounds, with curvilinear horizontal lines. A vanishing point is
placed in the middle of the horizon line, to help draw lines on the z-axis, and two
vanishing points are placed on the horizon line outside of the camera field, to define
the curve of horizontal lines. Vertical lines are made perpendicular to the horizon
line.
This is useful for drawing backgrounds meant to be panned over horizontally.
Panning the camera horizontally over a background drawn with a 3-Point
Perspective (Horizontal Pan) guide will simulate a rotation of the camera on the yaxis.

l

The 3-Point Perspective (Vertical Pan) guide helps you draw vertically panoramic
backgrounds, with curvilinear vertical lines. A vanishing point is placed in the
middle of the horizon line, to help draw lines on the z-axis, and two vanishing
points are placed above and below the horizon line, outside of the camera field, to
define the curve of vertical lines. Horizontal lines are made parallel to the horizon
line.
This is useful for drawing background meant to be panned over vertically. Panning
the camera vertically over a background drawn with a 3-Point Perspective (Vertical
Pan) guide will simulate a vertical rotation of the camera on the x-axis.

l

The 4-Point Continuous Perspective guide is very similar to the 3 Point Perspective
(Horizontal Pan) guide, except that it is designed to help draw full 360° panoramic
backgrounds.
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This guide uses 5 vanishing points. When drawing a horizontal line, it is curved by
arching over one of the vanishing points and reaching down to the two surrounding
vanishing points. This creates a perspective effect where each vanishing point
represents one of the cardinal points, except that the leftmost and the rightmost
points represent the same cardinal point, effectively creating a looping background.
Backgrounds made with the 4-Point Continuous Perspective guide can be looped
horizontally to simulate a full rotation of the camera on the y-axis.

l

The 4-Point Perspective (Vertical Pan) is a lot like the 2-Point Perspective guide,
except that its vertical lines are curvilinear, so ti can be used to make vertically
panning backgrounds. Two vanishing points are on the horizon line, outside of the
camera field, to help draw lines on the x-axis and the z-axis, and two vanishing
points are placed above and below the camera field to define the curve of the
vertical lines.
This is useful for drawing backgrounds meant to be panned over vertically, in which
cuboids objects are seen from an angle.

l

The 5-Point Perspective (Fish Eye) guide helps you draw backgrounds that are
curvilinear on both the x-axis and the y-axis. It has one central vanishing point on
the horizon line, from which lines on the z-axis are drawn, two vanishing points at
the extremities of its horizon line, to define the curve of horizontal lines, and two
vanishing points above and below the horizon line, to define the curve of the
vertical lines.
This guide can be used to draw backgrounds with a fisheye-style wide angle lens
effect. It can also be used to draw backgrounds that are meant to be panned in
various directions.
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Each guide is available in the

Add Guide pop-up menu of the Guides view.

Rework line

If you press and hold the Alt key while drawing a line using a drawing guide, keep the Alt
key pressed afterwards, and start drawing again, you will keep drawing on the same axis.
This can be used to rework the thickness or length of lines you are drawing with a guide.

Guide angle display

When you rotate a guide, its exact angle is displayed in the top-left corner of the Camera
view.
Some guides are rotated by moving one of the two points on their horizon line, which
rotates them around the opposite point. If you press and hold the Alt key while moving one
of their points, it will rotate the guide around its centre instead. This works for the
following guides:

Rotate guide from centre

l

Ruler

l

2-Point Perspective

l

3-Point Perspective (Bird's-Eye View)

l

3-Point Perspective (Worm's-Eye View)

Deformations
Feature

Description

Free Form Deformation

The new Free Form Deformation is a type of deformer that can be used to deform textures.
It works by creating points anywhere inside an element, then manipulating these points to
deform the element in a way similar to pulling on different parts of a piece of cloth.
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To create a Free Form Deformation, select the Rigging tool in the Deformation toolbar.
Then, in the Tool Properties view, select

Free Form Mode. Select the element you want

to deform, and click where you want to create deformation points.

Show deformations without
hiding others

A

Show Selected Deformers button was added to the Deformation toolbar. Contrary to

the existing

Show Selected Deformation Chains and Hide All Others button, this button

displays the deformation chain for the selected element without hiding others.

Digital Animation
Feature

Description

It is now possible to add horizontal and vertical rulers, referred to as alignment guides, to
the Camera view. Alignment guides are visible when the Transform tool is selected, and can
be used to help you align elements to specific areas of the stage.
l

Alignment guides in the Camera
view

You can add guides using the

New Horizontal Alignment Guide and

New

Vertical Alignment Guide buttons in the toolbar above the Camera view.
l

You can manipulate alignment guides using the

l

You can hide or display guides by toggling the

Transform tool.
Show Alignment Guides button

in the toolbar below the Camera view.
l

You can lock or remove alignment guides using the menu commands available
when selecting View > Alignment Guides in the top menu.
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l

You can make elements snap to alignment guides by enabling the

Snap

to Alignment Guides option of the Transform tool in the Tool Properties view.
It is now possible to add coloured markers to frames in the Timeline view. Frame markers
differ from drawing markers in that they are not tied to a drawing, but to a frame. They can
be added to any frame, whether or not it contains a drawing. They also differ from scene
markers as they are added to specific layers rather than the entire scene, and only mark a
single frame.
Frame markers

To add a frame marker, right-click on a frame in the Timeline view and select Mark Frame,
then select the desired colour to mark the frame with.
It is possible to assign keyboard shortcuts to quickly navigate between frame markers,
whether of any colour or of a specific colour. Those keyboard shortcuts can be set in the
Timeline section of the Keyboard Shortcuts dialog.

Exclude layers in Pose Copier

The Pose Copier dialog now allows you to select layers in your rig to exclude from the pose
copying process. This can be useful if you have a template containing many full character
poses, but you only want to paste certain parts of these poses on your character.
To use this feature, first, select every layer you want to exclude in the Timeline view. Then,
right-click on them and select Tag > Timeline Tag. Then, once in the Pose Copier dialog,
check the checkbox next to the Exclude Layers button, then click on this button.

Node View
Feature

Preference for pass through
composite as default

Description

There is now a preference to make new Composite nodes in Pass Through mode by default.
This preference, named Default Pass Through Composite, is available in the General
section of the Preferences dialog.
It is now possible to insert a composite in the middle of a connection cable by holding the
Alt key and moving it over the cable.

Rip & insert composite

It is also possible to rip a composite from a connection by holding the Alt key and moving it
out of its cables.
Up until Harmony, this was possible with every node that has at least one input and one
output port, except for the Composite node.

Straight cable display

It is now possible to display cables in the Node view as straight lines going directly from
one port to the other. This can be useful if your node network uses a lot of waypoints, as
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connections between waypoints display as straight lines.

Set composite mode on several
composites

Using the Set Properties on Many Layers dialog, you can change the mode of all composite
nodes in the selection to either As Bitmap or Pass Through.
To access this dialog, click on the

Set Properties on Many Layers button in the Node

View toolbar.

Effects
Feature

Description

A new Motion-Blur effect was added to Harmony. This effect has four significant
enhancements over the legacy Motion-Blur node:
l

l

New Motion Blur effect

l

l

It can blur animations on the angle and scale of elements, whereas the legacy
Motion-Blur effect only blurred translations.
It can be connected to a peg that will dictate the direction of the blurring effect, if
desired. Otherwise, it will use the direction of its input image, like with the legacy
Motion-Blur node.
It has a Preroll Motion option that allows you to simulate that the motion started
before the first frame of the scene, making the motion blur already in effect in the
first frame.
The motion blur effect continues even after its input element has exited the camera
field.

NOTE
The legacy Motion-Blur node was renamed Motion-Blur-Legacy.

A new chroma keying effect, the RGB-Difference-Keyer node, was added to Harmony. It
has the following enhancements over the legacy Chroma-Keying node:
l

New Chroma Keying effect
l

l

It has a lot more parameters, allowing you to customize properly how to select
which pixels in the input image to key out.
It is able to despill the borders of the output image without blurring it.
It can be used to apply the keyed matte to another image that the image used to
generate the matte.
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Performance
Feature

Description

It is now possible to make Harmony cache the output image of nodes and composites for
the OpenGL preview of the Camera view:
l

l

Each node that outputs an image has a Cached option. When enabled on a node,
Harmony generates the OpenGL preview of that node once, stores it in a cache, and
uses the cached image to display in the Camera view.
More importantly, if this option is enabled on a Composite node, the composite will
store each of its input images into separate caches.

This can significantly improve the performance of Harmony when working on heavy scenes
with several character rigs. For example, by enabling the Cached parameter on a Composite
node to which several character rigs are connected, the preview image of each of these
character rigs becomes cached.
Node & Rig Caching

Since a character rig that is cached cannot be manipulated, it is possible to temporarily
uncache a cached node or rig simply by clicking on it. Then, if you click on another cached
node or rig in the scene, the previously active node or rig becomes cached again, and the
newly selected node or rig becomes uncached.
To enable cache on a node or composite, open its layer properties and, in the top-right
corner, check the Cached checkbox.
You can also add the Node Caching toolbar to your workspace, with which you can enable
or disable caching on selected nodes and control how caching is temporarily disabled and
re-enabled.
The

OpenGL Node Caching Enabled button in the toolbar below the Camera view

allows you to toggle caching on and off, control what happens when a cached rig has
elements that are too far apart on the z-axis, and adjust the resolution of cached images.

Export
Feature

Description

It is now possible to export a movie in MPEG-4 (.mp4) format.
To export an MP4 movie, select File > Export > Movie from the top menu. Then, in the
Video Format drop-down, select H.264/MPEG-4 (*.mp4).
Export as MP4

NOTE
Movies export in MP4 format from Harmony use the H.264 video codec and have no
audio.
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Feature

New QuickTime movie interface
for macOS

Description

On macOS, Harmony now uses the Apple AVFoundation framework that is built into
macOS to export movies in QuickTime Movie (.mov) format, instead of the QuickTime
application.
This allows Harmony to export using the H.264, Apple ProRes 442 and or Apple ProRes
4444 codecs built into AVFoundation.

Import
Feature

Description

Import MP4/M4V

It is now possible to import MP4 or M4V movies into your scene. To import an MP4 or M4V
file, select File > Import > Movie from the top menu.

Preferences
Feature

Keyboard Shortcuts dialog

Create, export, import and
switch between keyboard
shortcuts sets

Export and import preferences

Default preference sets

Description

The Shortcuts tab of the Preferences dialog is now its own dialog, the Keyboard Shortcuts
dialog.
To access this dialog box, in the top menu, select Edit (Windows/Linux) or Harmony
[Edition] (macOS) > Keyboard Shortcuts.
It is now possible to create your own keyboard shortcut sets. You can also export your
keyboard shortcut sets as XML files and use them as backups or share them with project
collaborators.
You can create, export and import keyboard shortcut sets using the New, Load... and Save...
buttons at the top of the Keyboard Shorcuts dialog.
It is now possible to export your preferences as XML files, and use them as backups or
share them with project collaborators.
You can export and import preferences using the new Load... and Save... buttons at the top
of the Preferences dialog.
Harmony now comes preloaded with five different sets of default preferences, which you
can quickly switch between in the Preferences dialog.
Most of the preferences in these sets are the same, except for key workflow preferences
such as
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Focus on Mouse Enter, Default Separate Position for Pegs, Stop-Motion Keyframes,
Support Overlay Arts and Underlay Arts, Advanced Palette List and others. For more
information, refer to the Preferences guide.

Default preference overrides

You can use a specific preference set as the default preferences for Harmony users. To do
this, save this preference set as the file prefs_override.xml in the resources subfolder of the Harmony installation folder.

Installation
Feature

Description

The Harmony package for macOS now only contains a single application.
Single application on macOS

You can launch any of the side applications bundled with Harmony, such as License
Wizard, Control Center and Configuration Assistant, by first launching Harmony, then
selecting Harmony [Edition] > Harmony Tools from the top menu.
The way Harmony is packaged for macOS no longer triggers the operating system's

Easy authorization on macOS

security mechanisms. Hence, it is no longer required to right-click on Harmony, select Open
and authorize the application as a user with administrative privileges to be able to run
Harmony and its side applications. You will be able to launch Harmony as soon as it is
copied to your Applications folder.

Enhancements
l

When drawing, the preview of the stroke now refreshes four times as fast, making it feel smoother and more
responsive.

l

The version of the Cisco OpenH264 library used by Harmony was upgraded to 1.8.

l

The Draw Circle and Draw Square options for the

Ellipsis and

Rectangle tools are now togglable icon

buttons in the Tool Properties view.
l

The Centerline Smoothing slider has been removed from the Tool Properties view for the

Brush and

tool. It is now only available in the Brush Properties and Eraser Properties dialogs.
l

The Apply Parent Modifier's Transformation property of Curve nodes has been renamed Apply Parrent
Transformation.
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Fixed Issues
l

Harmony sometimes fails to initialize the sound drivers before playback on Windows.

l

Crash when attempting to view the layer properties of an Element node created when the Preserve Line Thickness
By Default preference is enabled.

l

Rare crash when using curve or envelope deformations on a drawing with pencil lines.

l

Rare crash when undoing a modification with the

l

Harmony may crash when attempting to move the Playback toolbar on macOS.

l

Harmony crashes when selecting artwork from multiple art layers and multiple drawing layers at the same time,

Contour Editor.

then copying and pasting it into a different layer.
l

Harmony crashes when selecting Top in the Monitored Attributes list of a Master Controller wizard, then clicking
on the

Search button.

l

Harmony crashes when manipulating a 3D Rotation widget in a Master Controller node.

l

Harmony crashes when attempting to rename a newly created template while the Library view is in Detailed
display mode on Windows in Stand Alone mode.

l

Crash when copying and pasting Master Controller nodes using the copyPaste scripting object.

l

Crash when dragging and dropping a vector or bitmap image from the Library view to a cell in the Xsheet view.

l

Hang when opening the

l

Output image of composite node does not appear in rendered image if the composite is connected both an element

View menu of the Drawing Substitutions view if no layer is selected.

that is at a position higher than 0 on the z-axis and a node such as the Line Art, Color Art, Underlay, Overlay, Image
Switch or Layer Selector node with no input image.
l

Drawing slowly on a pen tablet on macOS results in shaky lines.

l

When drawing a very long brush stroke, then immediately drawing another stroke, the second stroke starts off
with a straight line segment.

l

When using the

Stamp tool with the

Draw Behind option, the order in which the strokes in the artwork of

the stamp are laid on top of each other is reversed.
l

Random effect of Quake node, Shake node and Lens Flare node renders differently on Windows, macOS and
GNU/Linux.
NOTE
To avoid affecting existing scenes, this fix only applies to Shake, Quake and Lens Flare Nodes created in
Harmony 17 or later. To use the new, platform-independent random effect on a node created in an
older version, open its layer properties and set the Version property to 2.

l

Rendering of 3D models through Maya using Renderman does not work with Renderman 22.0 or later.
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l

Attempting to use Unicode characters in a scene or layer name does not work on certain GNU/Linux machines.

l

Dependencies of Master Controller do not get copied into the scene when inserting a template that contains a
Master Controller from a different job folder.

l

Elements connected to a Pixelate node are invisible in the OpenGL preview of the Camera view.

l

After having synced a layer with another layer, then unsyncing it, it is impossible to sync it with a different layer.

l

Using the

Reposition All Drawings tool in the Drawing view offsets a drawing multiple times if it is exposed

multiple times.
l

Copying and pasting text with rich text formatting into any of the script fields of the Layer Properties for a Master
Controller or Script node may result in illegible or scrambled text.

l

Exporting a QuickTime movie via the scripting interface fails when passing -1 as the horizontal and vertical
resolution. Using -1 is supposed to make it use the default preview resolution instead.

l

When pasting layers using Paste Special, with the Palettes option set to Copy and create new palette files in
element folder, the palette files get copied to their origin folder and renamed.

l

Empty Group layer gets locked and cannot be unlocked when collapsed in the Timeline view.

l

Many translation issues across the user interface.

l

The Play application always launch in Stand Alone mode in Japanese.

l

No option to import 3D models in trial mode in Japanese.

l

Error message when clicking on the

l

The

l

Layer properties of Master Controller or Script node do not have a scroll bar when they exceed the available display

Save Grid Preset button in the Grid Wizard.

Load Grid Preset button of the Grid Wizard opens an Open File dialog, then displays an error message.

space.
l

When using a Master Controller wizard on GNU/Linux, the .tbState extension is not automatically added to the
pose databases file generated for the Master Controller.

l

Seams may appear where different colour zones meet when looking at a drawing with the Backlight mode enabled,
at certain zoom levels, in the Drawing view.

l

Pencil icon next to modified drawings in Xsheet view is not properly centred on macOS that use a Retina display.

l

Some brush tips and paper textures that were included in Harmony 15 were missing in Harmony 16.

l

Progress bar window appears at the top of the screen when movie file on macOS.

l

Up & down buttons right of decimal number input fields appeared only on Windows and GNU/Linux, and only
when using dark style.

l

Cannot select a node by clicking on its debug information, when Debug mode is enabled.

l

Empty item in Undo/Redo list after using the Rename Transformation button of the Deformation toolbar.
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l

Tool tips of Game Skinning toolbar are not translated in other languages.

l

Buttons to flip a stamp horizontally or vertically in the Tool Properties view appear too small when using a Retina
display on macOS.

l

When customizing certain toolbars such as Master Controller, Deformation, Shift and Trace, Mini Playback, Game
Skinning and Master Controller, clicking on Default will remove all the buttons from the toolbar.

l

When nudging a deformation point with the keyboard while in

Animate Off mode, the deformation point moves

too far.
l

If the toolbar for a specific view is hidden, it reappears after switching to another view, then back to that view.

l

Impossible to select a point with the

l

Some frames may be corrupted when exporting a Windows Media Video (.wmv) file at 100% quality.

l

When copying and pasting artwork from multiple art layers, with the

Contour Editor using a tablet pen.

Apply to Line Art and Colour Art tool

property enabled, all of the artwork ends up only on the current art layer.
l

Content of Grid Wizard dialog shifts when selecting or deselecting a grid point on macOS.

l

Exporting layout images in PSDDP4 format results in 8-bit/channel PSD images, whereas they should be 16bit/channel.

l

Many preferences are not restored to their default value by the Restore All Defaults button.

l

When using drawing guides, using the arrow keys to switch between axes also changes the current Stamp tool
drawing.

l

Using the [ and ] keyboard shortcuts to substitute the current drawing does not work in the Timeline view, the
Node view or the Library view.

l

Crash when deleting a composite node inside a group if the composite node is connected to multiple input images
going from the Multi-Port-In node and some of its cables are crossed.

l

Keyframe is created when modifying a deformation point with the

Rigging tool.

l

Custom configuration of certain toolbars is not preserved after closing Harmony.

l

Harmony cannot load SDK plugins unless their path is specified in the TOONBOOM_PLUGINPATH environment
variable on GNU/Linux.

l

Some synced layers are ignored when using the Pose Copier dialog with a template that has synced layers.

l

Drawings offset with the

l

Selected preset for the

l

Changing the scene's length from the Timeline view while it is fully zoomed-in positions the end-of-scene handle

Shift and Trace tool appear offset when using Mini Playback.
Pencil tool and the

Eraser tool are swapped each time Harmony is launched.

one frame off the actual end of the scene.
l

Errors in the script samples of the Master Controller widgets provided in the scripting documentation.
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l

Bounding box of element selected with the Transform tool is inaccurate if the element is selected while the Camera
view is rotated, then the Camera view is reset to its default angle.

l

Render Preview node does not update when selecting a frame in the Timeline view if the Enable Interactive
Camera View Cache preference is enabled.

l

Error messages appear when cancelling any operation while creating a Master Controller using one of the Master
Controller wizards.

l

View-specific toolbars are not listed in the context menu when right-clicking on the toolbar area of a view.

l

Using the Lock All or Lock All Others commands lock group layers in the Timeline view.

l

Opening the Layer Properties dialog for a locked layer locks all of its children in the Timeline view.

l

Using the Configuration Assistant to add the path to the Harmony executables to the $PATH environment variable
on macOS does not always work.

l

If two Harmony Server scenes with the same name but different environments are open at the same time, the
Database Lock Manager will always display the locks for both scenes when trying to view the locks for only one of
them.

l

The -adjustpencil parameter of the utransform does not work.

l

The

l

The Line Art options in the Nodes ViewLayer tab of the Preferences dialog are inverted.

l

Options for the

l

Wrong translation of the word "name" is used in the Welcome dialog in Japanese.

l

Name of some tool properties may not appear translated when using Harmony in a language other than English.

l

The FixURLHandler.sh script packaged with the macOS edition does not work when run from any directory but

Perspective tool performs excessive smoothing on the selected artwork.

Centerline Editor tool are labeled "Contour Editor Options" in the Tool Properties view.

its own directory.
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